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1 Einleitung
MapRun ist eine App für Smartphones (iPhone oder Android) um Orientierungsläufe 
durchzuführen. Die Posten werden dabei als Koordinaten hinterlegt und durch das GPS im
Smartphone registriert, wenn ein Läufer dort vorbeikommt. 

Zusätzlich kann auch eine Karte hinterlegt werden, d.h. das Smartphone kann auch zur 
Orientierung selbst verwendet werden. Hintergrund war hier, dass man ursprünglich einen 
einfachen Einstieg in den OL über Festpostennetze anbieten wollte. Bei offiziellen 
Wettkämpfen wird diese Karte auch für die Auswertung über RouteGadget verwendet.

Des Weiteren gibt es noch eine App MapRunG für Garmin GPS Uhren. Dabei werden die 
Koordinaten der Posten auf die Uhr übertragen und es muss kein Smartphone beim Lauf 
verwendet werden.

Die Apps MapRunG und MapRun sowie deren Vorläufer MapRunF und MyOMaps wurden 
größtenteils vom australischen OL Verband finanziert, allerdings entstehen durch den 
Betrieb (Serverkosten, Lizenzen, u.s.w.) weitere Kosten. Die offizielle Aussage lautet, dass
0,50 USD (≈ 0,42 €) pro Lauf die Kosten decken würden. Auf der Homepage 
(http://maprunners.weebly.com/) befindet sich dazu eine Spendenmöglichkeit.

Die Screenshots dieser Anleitung stammen noch aus MapRunF, sind aber weitestgehend 
gleichgeblieben.
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2 Laufen mit MapRun
Es gibt drei Arten MapRun zu verwenden:

1. Mit Smartphone (Siehe 2.1)

2. Mit App fähiger Garmin GPS Uhr (Siehe 2.2)

3. Mit beliebiger GPS Uhr (Siehe 2.3)

2.1 MapRun – Smartphone App

2.1.1 MapRun – Installation

Die App kann kostenlos aus dem App Store (iPhone) bzw. Googleplay (Android) geladen 
werden.

Der App müssen alle erforderlichen Rechte (insbesondere Zugriff auf Internet und GPS) 
gegeben werden.

Nach der Installation kann man die App öffnen und im Menü „Name“ die Informationen 
zum Läufer pflegen:

Mit der Taste „Accept“ bestätigt man die Eingaben und kommt wieder ins Hauptmenü 
zurück.
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Feld Beschreibung

Surname Nachname

First Name Vorname

Gender M oder F

Email Address Email

Mobile Phone Kann leer bleiben.

Year of Birth Geburtsjahr

Postal Code PLZ

Club or Team Club (optional)



2.1.2 MapRun – Verwendung

2.1.2.1 Laufen mit MapRun

Um die App zu verwenden, wählt man zuerst einen Wettkampf aus:

1. Offizielle Wettkämpfe (Siehe 3.5) werden über „Select Event“ ausgewählt. 
Anschließend navigiert man durch die Ordnerstruktur in den Ordner 
Germany/Baden Württemberg. Dort befinden sich dann in Unterordnern die 
einzelnen Wettkämpfe.

2. Testläufe (Siehe 3.4) werden über die Option „Check Sites“ im Zusatzmenü 
ausgewählt. Jeder Testlauf hat eine 6 stellige Codenummer, die eingegeben werden
muss.

Anschließend wählt man die Option „Go to Start“. Bei PIN geschützten Wettkämpfen muss
dann noch eine 4 stellige PIN eingegeben werden. Die aktuelle Position wird auf dem Weg
zum Start durch eine rote Linie angezeigt. Wenn man den Start erreicht hat, läuft die Zeit 
von selbst los.
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Während des Laufens braucht die App nicht aktiv bedient zu werden. Die Posten werden 
durch GPS automatisch registriert und der Code des zuletzt gelochten Posten angezeigt. 
Am Ziel stoppt die Laufzeit automatisch und die Ergebnisse werden automatisch 
hochgeladen.

2.1.2.2 Technische Hinweise zu MapRun

• Da die Zeit am Ziel automatisch stoppt, darf man nach dem ersten Posten nicht 
vorzeitig am Ziel vorbeilaufen.

• Smartphones sind sehr empfindlich – insbesondere bei Stürzen. Für die Mitnahme 
empfehlen sich Handy - Sportarmbänder oder Trinkgürtel, wie man Sie vom 
Langlauf kennt.

• Falls das GPS den aktuellen Posten nicht registrieren sollte, gibt es mehrere 
Lösungen:

1. 5 Sekunden stehen bleiben, reicht meistens

2. Einmal im Radius von ca. 15 Meter um den Posten laufen

3. Weiterlaufen und nach dem Lauf den Posten korrigieren. (Siehe 2.1.2.3)

• Während des Laufs braucht das Smartphone keine aktive Internetverbindung – die 
wird nur zum Runterladen des Wettkampfs und zum Hochladen der Ergebnisse 
benötigt.

• Falls mit Smartphone gelaufen wird, muss der Energiesparmodus aus, GPS an und
der Akkustand möglichst hoch sein. Außerdem sollte der App erlaubt werden im 
Hintergrund zu laufen.
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2.1.2.3 Ergebnisse auswerten mit MapRun

Die Auswertung wird über die Option „Show Results“ angestoßen. Danach wählt man den 
passenden Lauf aus und kommt auf die Ergebnissicht mit der Karte und der rot 
eingezeichneten Bahn.

Über das Kontextmenü rechts oben kann man sich auch die Splitzeiten ansehen.

Die Option „All Results for this Event“ führt zu einer Ergebnisliste dieses Wettkampfs. 
(Nicht bei Testläufen.) Die Option „Tracks“ öffnet dann Routegadget.
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Falls ein Posten nicht vom GPS registriert wurde, kann man manuell nachkorrigieren. 
Dafür verwendet man die Option „Review Results (HITMO)“. Nicht gelochte Posten 
werden rot dargestellt und können über ein Ankreuzfeld in Spalte Select übernommen 
werden. Zum Schluss übergibt man das korrigierte Ergebnis mit der Option „Submit a 
Revised Result“.

Da Routegadget und Splitsbrowser auf mobilen Endgeräten nur sehr eingeschränkt 
funktionieren, kann man sich die Ergebnisse auch per Browser (Link) ansehen. Im Feld 
Filter kann man dazu z.B. „GERBW“ eingeben, damit nur Ergebnisse aus BW angezeigt 
werden.

2.2 MapRunG – App für Garmin GPS Uhren
Zusätzlich zu MapRun gibt es noch die App MapRunG für Smartwatches von Garmin. Die 
GPS Uhr muss dazu Connect IQ-Apps vollumfänglich unterstützen (Aktuelle Modelle). 
Einige Uhren z.B. Forerunner 45 erlauben nur das Herunterladen von Displaydesigns – 
das reicht nicht. Im Zweifelsfall bitte die technischen Daten auf der Homepage 
konsultieren:
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https://buy.garmin.com/de-DE/DE/c10002-p1.html?FILTER_USERPROFILE_CONNECTIQAPPS=true&sorter=featuredProducts-desc
http://www.p.fne.com.au/rg/cgi-bin/SelectResultFileForSplitsBrowserFiltered.cgi?HideCombinedResults=yes


MapRunG hat einige Vorteile ggü. MapRun:

• Man muss kein Handy zum Lauf mitnehmen.

• Der Akku einer Uhr hält i.A. länger als der eines Handy.

• Der GPS Empfang von Garmin Uhren ist i.d.R. besser als von Handys.

• Allerdings haben wohl einige ältere Modelle z.B. Forerunner 230/5 eine Limitation 
auf max. 35 – 40 Posten, da der Speicher nur 64kB groß ist.

2.2.1 MapRunG – Installation

Als Voraussetzung muss ein Garmin Connect Konto (Link) für die Uhr existieren. Die App 
kann dann direkt aus dem Connect IQ Store (Link) auf die Uhr runtergeladen werden.

Die Uhr muss dann noch mit der Handy App MapRun verbunden werden. Dazu startet 
man die App auf der Uhr um die ID der Uhr zu erhalten.

Diese ID muss man anschließend in den Optionen manuell eingeben um die Verbindung 
mit Garmin Connect herzustellen:
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https://apps.garmin.com/de-DE/apps/05fa6a5e-e9e6-4865-8b3b-0b8a3c64eeba
https://connect.garmin.com/signin/


2.2.2 MapRunG – Verwendung

Wettkämpfe werden im Smartphone über die App MapRun ausgewählt (Siehe 2.1.2.1) und
danach über die Option „Send Event to my Garmin Watch“ an die Uhr übertragen. (Die 
Option ersetzt somit die „Go to Start“ Option.) 

Voraussetzung ist eine bestehende Bluetooth Verbindung zwischen Smartphone und Uhr. 
Bei der Übertragung werden auch Einstellungen wie Wettkampftyp oder Genauigkeit der 
Posten an die Uhr gesendet. Auf der Uhr können keine Einstellungen verändert werden.

Wenn man jetzt die App auf der Uhr öffnet, kommt man normalerweise auf ein Bild mit 
Informationen zur Bahn (Name, Typ(Line, Score, ...), Radius für Posten, Postenanzahl) 
sowie der GPS Genauigkeit. Falls man den Wettkampf schon mal ausgewählt hatte, 
kommt ein Fehlerbild das man wegklicken kann. Im nächsten Bild kann man dann „Use 
stored“ auswählen und landet dann wieder auf dem Bild mit der Bahninfo.

Um den Wettkampf zu starten, geht man zum Start und drückt die Start/Stop Taste. Im 
Idealfall registriert das GPS den Start und zeigt dann „S1“ als letzten gelochten Posten an.
Danach kann man die Strecke regulär ablaufen. Wenn man am Posten ist, registriert die 
Uhr dies, vibriert und zeigt den Code des letzten Posten an. Beim Erreichen des Ziels 
stoppt die Zeit automatisch. Es erscheint dann noch eine Abfrage auf der Uhr, ob man den
Lauf wirklich beenden (Finish) will, die man bestätigen muss. 
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Die Ergebnisse werden bei bestehender Internetverbindung automatisch an Garmin 
Connect übertragen. Um diese herunterzuladen, wählt man die Option „Show Results“ und
lädt dann mit „Get track from Garmin“ den passenden Track herunter.

Der Rest ist analog zu MapRun (Siehe 2.1.2.3)

Bei Problemen mit der Empfangsgenauigkeit (betrifft wohl vor allem schnellere Läufer) 
wird empfohlen die Datenaufzeichnung von „intelligent“ auf „1 Sekunde“ umzustellen. 
(Menü → Einstellungen → System → Datenaufzeichnung)

2.3 GPX Upload – GPS Uhren ohne App verwenden
Falls man eine GPS Uhr hat, welche die MapRunG App nicht unterstützt, kann man den 
Lauf aufzeichnen, im GPX Format speichern und anschließend hochladen. Da man dabei 
natürlich am Posten keinerlei Rückmeldung von der Uhr bekommt, macht das eigentlich 
nur Sinn, wenn die Posten im Gelände markiert sind.

Um die GPX Datei hochzuladen, verwendet man das Formular auf der MapRun 
Homepage (http://www.p.fne.com.au/#/gpsupload).

11

Feld Beschreibung

GPX file to upload GPX Datei zum hochladen

Event Name des Wettkampfs

First Name Vorname (Kontakt)

Surname Nachname (Kontakt)

Male/Female Geschlecht

Year of birth Geburtsjahr (nur letzte 2 Stellen, z.B. 81)

Email Adress Email (Kontakt)

Timing Method Sollte auf GPSWatch (Start and Finish times determined automatically from the 
GPS Track (Approximate Timing)) stehen

Threshold in 
meters

Auf Standardwert 45 lassen

http://www.p.fne.com.au/#/gpsupload


Wenn man dann auf „Analyse Track“ klickt, bekommt man eine Liste der Posten inkl. Zeit 
und Abstand zum Posten. Mit den blauen Kontrollkästchen kann man Lochungen manuell 
umsetzen.

Die Lochungen werden mit „Confirm Results Table“ bestätigt, worauf noch einige Felder 
angezeigt werden, die man i.d.R. unverändert übernehmen kann.

Abschließend bestätigt man das Ganze mit „Submit Results“ und die Ergebnisse werden 
hochgeladen. 

Der Satz taucht dann zwar in der Ergebnisliste auf, allerdings fehlen manchmal die Daten 
für Routegadget/Splitsbrowser. Dazu muss ein Admin den Wettkampf „refreshen“.
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Feld Beschreibung

Gross Score Score: Gesamtpunkte

Net Score Score: Nettopunkte (Gesamtpunkte – Strafpunkte wegen Zeitüberschreitung)

Distance run Gesamtdistanz



3 Wettkämpfe anlegen für MapRun
Um Wettkämpfe für MapRun anzulegen, benötigt man zwei Dateien:

1. Eine Kartendatei im KMZ Format, d.h. ein Bild der Karte mit passenden 
Koordinaten (Siehe 3.2)

2. Eine Bahndatei im KML Format, d.h. die Koordinaten der Posten (Siehe 3.3)

KMZ und KML sind die beiden Standardformate von Google Earth und werden beide 
meistens gleichzeitig zum Speichern angeboten. KML ist lediglich eine Textdatei mit XML 
Inhalt, während KMZ ein Zip Archiv mit mehreren Dateien (i.d.R. eine KML und mehrere 
Bilder) ist.

Es gibt mehrere Arten von Wettkämpfen, von denen wir hier aber nur Testwettkämpfe 
(Siehe 3.4) und offizielle Wettkämpfe (Siehe 3.5) betrachten.

Wir gehen im folgenden davon aus, das Koordinaten im Format UTM/UPS und 
Kartendatum WGS 84 vorliegen.

3.1 Verwendete Software
Es führen mehrere Wege ans Ziel. Der offiziell empfohlene lautet z.B.: 

1. Bahnlegung mit Google Earth 

2. Nach dem Erstellen des Wettkampfs wird eine Purple Pen Datei generiert, die zum 
Drucken der Bahnen verwendet werden kann.

In der Praxis sind wir jedoch immer umgekehrt vorgegangen:

1. Bahnlegung und Druck mit OCAD, Condes oder PurplePen

2. Import der Bahn nach Google Earth

Je nachdem wie die Softwareausstattung aussieht und in welchen Formaten Karte und 
Bahn vorliegen, ergeben sich mehrere Möglichkeiten.

3.1.1 Google Earth Pro(GE)

Google Earth Pro(GE) (https://www.google.de/earth/download/gep/agree.html) ist die 
einzige zwingend erforderliche Software. Sie kann dazu benutzt werden, die Kalibrierung 
der Karte zu überprüfen und um die Bahnen zu erzeugen.

Folgende Einstellungen (Menü Tools → Optionen…) sollte man verändern:
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Falls die Karte sich verdreht haben sollte, kann man einfach die Taste „R“ drücken. Ein 
wichtiges Feature von GE sind historische Bilder. (Menü → Ansicht → Historische Bilder) 
Für uns sind vor allem Winterbilder interessant, da die Laubbäume dann keine Blätter 
haben.

Kartendateien können in GE stufenlos transparent dargestellt werden.

Leider ist die eingebaute Funktion (Menü Hinzufügen → Bild-Overlay) um eine Karte zu 
kalibrieren absolut unbrauchbar.
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3.1.2 OCAD Viewer

Den OCAD Viewer (https://www.ocad.com/de/viewer/) kann man benutzen, wenn die 
Karten in alten OCAD Versionen (vor OCAD 10) vorliegen oder wenn man Bahn bzw. 
Karte in einer zu hohen Version zur Verfügung gestellt bekommt. Falls man die Lizenz für 
eine aktuelle OCAD Version hat, kann man darauf verzichten.

3.1.3 GPS Utility (GPSU)

GPS Utility (GPSU) (https://www.gpsu.co.uk/download.html) kann verwendet werden um 
Karten zu kalibrieren. Die unregistrierte Freeware Variante kann Karten bis zu 2000 x 2000
Pixeln kalibrieren. Insbesondere kann GPSU mit World Dateien aus OCAD/OOMapper 
arbeiten. Beim ersten Start (Menü File → New) sollte man Koordinatenformat und 
Kartendatum einstellen.

3.1.4 Online Utilities von MapRun

Es gibt eine Seite (http://www.p.fne.com.au/rg/cgi-bin/o-utils.cgi) mit diversen online 
Hilfsfunktionen. Am häufigsten benötigt man die beiden „Create KMZ file...“ Funktionen.

3.1.5 Online Utility – Icons von KML Datei setzen

Es gibt auf der MapRun Homepage (Link) Icons für Startdreieck, Posten- und Zielkreis. 
Diese kann man in ein lokales Verzeichnis runterladen. Unter http://maprunutil.bplaced.net
befindet sich ein einfaches Tool, dem man dieses Verzeichnis und eine KML Datei 
mitgeben kann und das anschließend eine KML Datei mit diesen Icons erzeugt. 

3.2 Erstellung der Kartendatei
Die Karte muss als KMZ Datei mit Teilbildern (Kacheln) der Größe 512 x 512 Pixel 
vorliegen. Die Kacheln erlauben schnellere Ladezeiten auf Smartphones. Für die 
Auflösung werden 150 dpi empfohlen, damit die Dateien nicht zu groß (> 1,5 MB) werden. 
KMZ Dateien können mit GE betrachtet werden.

3.2.1 Aus georeferenzierter OCAD Karte (aktuelle OCAD Version)

Ab OCAD 10 existiert ein direkter KMZ Export (Menü Datei → Exportieren):
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Die Kachelgröße (Tiles) und Auflösung (Resolution) kann direkt eingestellt werden. 
Außerdem sollte nur die Teilkarte (Part of map) exportiert werden, die wirklich benötigt 
wird.

3.2.2 Aus georeferenzierter OCAD Karte (alte OCAD Version)

Falls die Karte älter als OCAD 10 oder neuer als die höchste verfügbare OCAD Version 
ist, kann man den OCAD Viewer (Siehe 3.1.2) verwenden. Der OCAD Viewer hat einen 
Export nach JPEG (Menü Datei → Exportieren) bei dem auch ein World file (*.jgw) mit 
Koordinaten exportiert wird. 

Danach kann man dieses Bild (*.jpg) mit GPSU (Siehe 3.1.3) öffnen (Menü 1. File → New, 
2. View → Map, 3. File → Load Bitmap) wobei das World file automatisch mit eingelesen 
wird. Anschließend speichert man das KMZ. (Menü File → Save Bitmap as Overlay). 

Um das KMZ in Kacheln aufzuteilen, verwendet man die Online - Funktion „Create KMZ 
file with 512x512 tiles from an un-tiled KMZ file“ (Siehe 3.1.4)

3.2.3 Aus georeferenzierter OOMapper Karte

Der OOMapper hat ab Version 0.9.5 einen KMZ Export (Menü Datei → Exportieren als… 
→ KMZ). Bei älteren Versionen kann man ein Bild als JPEG mit World file exportieren. 
(Menü Datei → Exportieren als… → Bild) Danach kann man analog OCAD Viewer (Siehe
3.2.2) vorgehen.
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Alternativ kann man das Koordinatensystem der Karte (Menü Karte → 
Georeferenzierung...) auf EPSG Code 3857 ändern und dann direkt mit der Online 
Funktion „Create a KMZ file (with 512x512 tiles) from a jpg and jgw file“ (Siehe 3.1.4) die 
KMZ Datei erzeugen.

3.2.4 Aus Bilddatei (z.B. JPEG)

Falls keine georeferenzierte Karte vorliegt, kann man eine Bilddatei (z.B. JPEG) manuell 
kalibrieren. Dazu bestimmt man zwei Punkte auf der Karte, die diagonal weit auseinander 
liegen (z.B. links oben und rechts unten). Die Punkte müssen auf dem Luftbild gut zu 
erkennen sein, damit man die Koordinaten bestimmen kann (z.B. Wegkreuzungen). Häufig
braucht man mehrere Versuche bis die Kalibrierung passt, da diese Kalibrierungspunkte 
nicht immer genau mit dem Luftbild zusammen passen.

3.2.4.1 Online Kalibrierung

Es gibt ein (etwas verstecktes) Tool auf der MapRun Seite (Link). 

Man kann dort das Bild hochladen („Choose File“) und den folgenden Bildschirm mit 
„Confirm“ quittieren.
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Anschließend kommt man auf das Kalibrierungsbild: Links wird die Karte und rechts ein 
Luftbild von Google (Start ist immer in Sidney...) angezeigt. In der Mitte beider Bilder 
befindet sich jeweils ein kleines rotes Zielkreuz. Man muss nun beide Kartenausschnitte 
so verschieben, dass beide Zielkreuze denselben Kalibrierungspunkt haben. Beide Bilder 
können auch gezoomt werden, das Kartenbild hat dazu unten einen grünen Regler, das 
Luftbild kann per Mausrad oder +/- Taste gezoomt werden. Wenn man fertig ist, drückt 
man links auf die Taste „Save Pin 1“.

Dann wiederholt man das Ganze für den zweiten Kalibrierungspunkt „Save Pin 2“ und 
landet so auf dem Überprüfungsbild. Mit dem Transparenzregler („Opacity“) kann man gut 
zwischen Bild und Luftbild hin -und herwechseln. Falls die Kalibrierung zu ungenau ist, 
kann man mit „Redo Pins“ neu kalibrieren. Ansonsten speichert man die KMZ Datei. 
(„Save as KMZ“)

Die Online Kalibrierung hat nur den Nachteil, dass man nicht steuern kann welches 
Luftbild genommen wird. Wenn man Pech hat, ist es ein Sommerbild auf dem die Bäume 
alles verdecken.

3.2.4.2 Kalibrierung mit GPSU und GE

Als erstes setzt man in GE die zwei Kalibrierungspunkte (Menü Hinzufügen → 
Ortsmarkierung). Dazu wählt man vorher am Besten ein historisches Bild (Menü Ansicht →
Historische Bilder) aus, auf dem viel zu erkennen ist.

Dann öffnet man in GPSU eine neue Datei (Menü File → New) und stellt sicher, dass die 
Koordinatendarstellung (z.B. UTM/UPS (E/N)) passen. Kartendatum in GE ist WGS84.
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Danach geht man in GPSU in die Kartendarstellung (Menü View → Map) und öffnet die 
Bilddatei (Menü File → Load Bitmap…). 

Um das Bild zu kalibrieren, klickt man auf der Karte auf den ersten Kalibrierungspunkt und 
gibt die Koordinaten der passenden Ortsmarkierung ein. Mit den Pfeiltasten im rechten 
Bereich kann man die Position auf der Karte fein kalibrieren. Im Feld ID vergibt man einen 
beliebigen Namen, z.B. CAL1.

Das Ganze wiederholt man für den zweiten Kalibrierungspunkt und danach ist die Karte 
kalibriert. Anschließend exportiert man die Karte (File → Save Bitmap as Overlay) als .kmz
Datei und konvertiert die KMZ Datei mit den Online Utilities (Siehe 3.1.4) in die Version mit
den Kacheln. (Analog zu 3.2.2)

3.3 Erstellung der Bahndatei
Die Bahndatei enthält die Koordinaten der Posten. Die Bahn kann direkt in GE erstellt 
(Siehe 3.3.1) werden oder auch aus OCAD (Siehe 3.3.3), Condes (Siehe 3.3.4) oder 
PurplePen (Siehe 3.3.5) importiert werden. 

Die Positionierung der Posten ist der kritischste Teil von MapRun. In offenem Gelände 
kann man versuchen, die Posten in GE anhand des Luftbildes feinzujustieren. Im Wald 
geht das praktisch nie, d.h. man muss sich dort auf die Karte verlassen. Abweichungen 
zwischen Posten und GPS Koordinaten von 10 Meter sind dann keine Seltenheit. Bei 
größeren Wettkämpfen macht es durchaus Sinn vorab mit GPS im Wald die 
Postenstandorte abzulaufen.

3.3.1 Technische Spezifikation

Die Bahndatei ist eine KML Datei und entspricht in GE einem Ordner mit mehreren 
Ortsmarkierungen (Menü Hinzufügen → Ortsmarkierung). Auf der Maprun Homepage 
(Link) befinden sich dazu auch Icons für Start, Posten und Ziel, die anstelle des Standard 
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http://p.fne.com.au/pins/


Icons verwendet werden können. (Nur zur verbesserten Darstellung in GE siehe auch
3.1.5) Der Ordner kann über „Ort speichern unter...“ als KML exportiert werden.

Folgende Punkte müssen beachtet werden:

• Jede KML Datei enthält genau einen Ordner und eine Bahn

• Der Start heißt immer „S1“ und das Ziel „F1“ (auch wenn unterschiedliche Bahnen 
verschiedene Starts und Ziele haben)

• Postencodes sind immer 2- oder 3-stellige Zahlen

• Bei der Benennung der KML Datei müssen spezielle Namenskonventionen (Siehe
3.3.1.1) befolgt werden

3.3.1.1 Namenskonventionen

Im Gegensatz zur Kartendatei müssen Bahndateien festen Namenskonventionen folgen, 
da aus dem Namen Ort und Typ des Wettkampfs abgeleitet werden. Es dürfen zudem 
keine Sonderzeichen (.,;:({[]}) nicht mal Unterstriche) im Namen vorkommen. Die 
allgemeine Form lautet: <REGION> <LOCATION> <COURSE> <CODES>.kml
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Feld Beschreibung Beispiel/Code

REGION Region (z.B. Baden Württemberg) GERBW

LOCATION Name der Karte evtl. zzgl. Datum im Format 
MMJJ

Schmellbachtal 1220

COURSE Bahnname Bahn 1, Mittel

CODES Mehrere durch Leerzeichen getrennte Codes:

4-stellige PIN (wird vom System generiert) PZ

4-stellige PIN mit Ablaufzeitpunkt (GMT) danach
kann man ohne PIN laufen

PZHHDDMMYYYY, PZ0031122021

Normale (Linien-) Bahn PXAC

Postennetz (alle Posten müssen abgelaufen 
werden, Reihenfolge egal)

PXAS

Postennetz (gewisse Anzahl der Posten 
müssen abgelaufen werden, Reihenfolge egal)

PXASxx, PXAS10

Score (so viele Posten wie möglich in max. 
Anzahl Minuten) Es gibt diverse 
Berechnungssysteme (Link).

PXAS ScoreQ60, PXAS ScoreG45

Massenstart (mit Vorbereitungszeit in Minuten) MX05

Keine Audio-/Vibrationssignale NXOFF

http://maprunners.weebly.com/scoring-schemes.html


Beispiele für Dateinamen:

GERBW Schmellbachtal 1220 Mittel PZ PXAC.kml

GERBW Schmellbachtal 1220 Score PXAS ScoreQ60.kml

3.3.2 Praktische Aspekte der Bahnlegung

Da die Postenkontrolle per GPS ungenauer als SI ist ergeben sich folgende 
Einschränkungen und Bemerkungen:

• Start und Ziel können generell identisch sein. Es muss aber sichergestellt sein, 
dass man nach dem ersten Posten nicht vorzeitig am Ziel vorbeikommen kann, da 
ansonsten der Lauf beendet ist.

• Schmetterlinge sind eigentlich nicht möglich, da ein Posten in einer Bahn nur 
einmal enthalten sein kann. Man kann höchstens für jede Wiederholung einen 
Dummy Posten mit eigenem Code anlegen.

• Posten mit mehreren Ebenen (Kellereingänge, Brücken) können nicht eindeutig 
zugeordnet werden.

• Posten ohne GPS Signal (Unterführungen, Durchgänge, zwischen hohen Häusern) 
können nicht registriert werden.

• Posten mit begrenztem Zugang (Sackgassen, Zauninnenecken) sollten vermieden 
werden, da bei einem Läufer das GPS Signal früher und bei dem anderen später 
kommt. Allgemein sind Postenstandorte, die von allen Richtungen aus angelaufen 
werden können, zu bevorzugen.

3.3.3 Import aus OCAD

OCAD bzw. der OCAD Viewer verfügt über einen direkten KML Export. (Menü Bahnlegung
→ Exportieren → Courses (KML)) Anschließend kann man noch die Icons hinzufügen 
(Siehe 3.1.5) und die KML Datei mit GE öffnen.

3.3.4 Import aus Condes

Condes hat ebenfalls einen direkten KML Export. (Menü Export → Bahnen für GPS 
exportieren) Anschließend kann man auch hier die Icons hinzufügen (Siehe 3.1.5) und die 
KML Datei mit GE öffnen.

3.3.5 Import aus Purple Pen

Der einzige brauchbare Export aus Purple Pen ist der GPX Export (Menü Datei → GPX 
File erstellen…). Man wählt dann die Bahnen aus, die man übernehmen möchte, lässt das
Namens-Präfix leer und wählt „OK“. 
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Es gibt ein Online Tool (Link), das dieses GPX in eine KML Datei umwandelt, allerdings 
werden dabei die Codes der Posten nicht übernommen, sondern nur beginnend mit 1 
durchnummeriert.

Man kann die GPX Datei aber auch direkt in GE öffnen. (Menü Datei → Öffnen…) Der 
Dateifilter muss auf Gps gestellt werden und bei den Importoptionen muss „Google KML-
LineStrings erstellen“ angehakt sein. Im Ordner „Tracks“ findet man dann zu jeder Bahn 
einen Ordner „Points“. Diesen speichert man als KML. 

Anschließend kann man noch die Icons hinzufügen (Siehe 3.1.5) und die KML Datei mit 
GE öffnen.

3.4 Testlauf erstellen (CheckSites)
Testläufe wurden ursprünglich dazu konzipiert, die Postenstandorte in Vorbereitung 
offizieller Wettkämpfe zu kontrollieren. Daher gibt es folgende Abweichungen:

• Jeder kann (auch ohne Adminrechte) Testläufe erstellen

• Testläufe haben nur eine begrenzte Gültigkeit

• Es gibt keine vergleichenden Ergebnisse (RouteGadget, Splitsbrowser) aber man 
sieht seine eigene Route/Zwischenzeiten nach dem Lauf auf dem Smartphone

• Testläufe können nicht mit PIN (Code PZ) gesichert werden, da jeder Testlauf 
standardmäßig einen 6 stellige Code bekommt.

• Einstellungen (wie z.B. Genauigkeit) werden nicht zentral vorgegeben sondern lokal
auf dem Smartphone gespeichert
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https://tools.widmann.ca/


Testläufe werden auf einer separaten Seite (Link) hochgeladen. 

Den 6 stelligen Code muss man sofort speichern, da er später nicht mehr ermittelbar ist.

3.5 Offiziellen Wettkampf erstellen und verwalten
Offizielle Wettkämpfe können nur von Administratoren erstellt und verwaltet werden. Die 
deutschen Administratoren sind auf der deutschen OL Homepage (Link) hinterlegt und 
können bei Bedarf kontaktiert werden.

Alle Admin Funktionen werden über eine zentrale Seite (Link) bereitgestellt.

3.5.1 Wettkampf anlegen

(Menü Admin Functions → Events → Add Event)

Zusätzlich können noch einige Einstellungen (Auswahl) vorbelegt werden, wobei die 
meisten aus dem Namen der Bahndatei abgeleitet werden. Bei einigen Einstellungen 
können Läufer lokal Anpassungen vornehmen, wenn man es zulässt.
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Feld Beschreibung

Event/Map Name Name der Bahndatei (Siehe 3.3.1.1) inkl. Codes (kein PZ !!!)

Expiry Date Ablaufdatum des Wettkampfs

First Name Vorname (Kontakt)

Surname Nachname (Kontakt)

Email Adress Email (Kontakt)

Map Kartendatei (Siehe 3.2)

Course Bahndatei (Siehe 3.3)

Submit Übermittelt die Daten und gibt den 6 stelligen Code zurück

Feld Beschreibung

Club Name Vereinsname

Event Date Erster Tag des Wettkampfs (Datum)

Event Level Local, International, National, Regional, Training

Folder Unter dem Bundesland (z.B. Germany\Baden Württemberg) wird ein 
Vereinsordner und darunter für jedes Laufgebiet einen separater Ordner 
angelegt

Map File Kartendatei (Siehe 3.2)

Course File Bahndatei (Siehe 3.3)

Resolution of KMZ Map Auflösung der Karte (50, 75, 100, 150, 200, 250, 300, 400, 600) dpi

Map Scale of KMZ Map Maßstab der Karte (1: 2000, 2500, 4000, 5000, 7500, 10k, 15k, 20k, 25k)

https://console.maprun.net/#/
https://o-sport.de/ol/informationen/interaktive-angebote-mit-maprun/
http://www.p.fne.com.au/#/checksitesupload


Wichtig ist vor allem der Parameter „Punch tolerance“: Bei Waldläufen sollte man hier auf 
20 hochgehen.

Wenn man den Wettkampf hochgeladen hat, bekommt man die PIN und kann optional die 
PurplePen Dateien mit der Bahn runterladen.

3.5.2 Wettkampf löschen

(Menü Admin Functions → Events → Delete Event)

Es wird immer der komplette Wettkampf (Bahnen und Ergebnisse) gelöscht. Dazu muss 
bei Option 1 der Name des Wettkampf ausgewählt werden.

3.5.3 Wettkampf verschieben

(Menü Admin Functions → Events → Move Event)

Es kann ein Wettkampf und ein Zielordner (kann auch ein neuer sein) ausgewählt werden.

3.5.4 PIN ermitteln

(Menü Admin Functions → Events → Display Event Code (PIN))

Man wählt den Wettkampf aus, drückt „Get Pin“ und erhält die Pin.
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Einstellung Standardwert Lokal anpassbar (Std.)

Event has 4 digit code Aus Bahnname Nie

Event allows runners to start at any control Aus Nie

No sound or vibration upon punching Aus Bahnname Möglich (Ja)

Controls change to green when punched An Möglich (Ja)

Display present location Aus Möglich (Nein)

Display track Aus Möglich (Nein)

Punch tolerance 15 (Möglich 
5,8,10,12,15,17,20,25,30)

Möglich (Nein)

Allow the user to submit revised results (HITMO) An Nie

Automatically upload results An Möglich (Ja)

Live tracking during the event Aus Möglich (Ja)

Display Orienteering Map Overlay An Möglich (Ja)

Opacity % of map Overlay 100% (Möglich 
0,20,40,50,60,80,90,100)

Möglich (Ja)

Display location pins Aus Möglich (Ja)

Map protected from reuse An Nie



3.5.5 Testlauf (CheckSites) runterladen

(Menü Admin Functions → Events → Download Files from CheckSites)

Man gibt den 6 stelligen Code ein und erhält Bahn- und Kartendatei. Abgelaufene 
Testläufe können nicht heruntergeladen werden.

3.5.6 Ergebnisse anpassen

(Menü Admin Functions → Results - Individual → Select for Action)

Man wählt den Wettkampf und anschließend den Läufer aus. Im folgenden Bild sieht man 
zwei Dateien (CSV und GPX) die man beide über das „Select Action“ Menü runterladen 
kann.

Die CSV Datei kann auch gelöscht werden, dann ist das gesamte Ergebnis des Läufers 
weg. 

Man kann die CSV Datei auch editieren und Name, Verein, Wertung u.s.w. verändern. 
Insbesondere kann man mit der Funktion „Admin HITMO“ fehlende Lochungen korrigieren.

Zum Schluss müssen die Änderungen mit „Refresh Event“ übernommen werden.
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3.5.7 Ergebnisse runterladen

(Menü Admin Functions → Results – Export)

Es gibt verschiedene Exportformate:
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Beschreibung Format Spalten

Mail Merge Event Results CSV Email, Vorname, Nachname, Wettkampf, Platz, URL 
Ergebnis, Zeit, Distanz, Schnitt, URL persönl. Ergebnis, 
Wertung

Mail Merge Runners Total 
(Anzahl Läufe in einem Ordner)

CSV Anzahl Läufe, Name, Email, Vorname, Nachname, 
Geschlecht, Geburtsjahr

Export Event Results CSV Wettkampf, Email, Vorname, Nachname, Geschlecht, 
Geburtsjahr, PLZ, Club, Startzeit, Zielzeit, Distanz, 
verwendete Software/Hardware, Wertung, alle 
Zwischenzeiten u.a.

Export Results for Eventor XML Wettkampf, Email, Vorname, Nachname, Geschlecht, 
Geburtsjahr, PLZ, Club, Startzeit, Zielzeit, Position, 
Wertung, alle Zwischenzeiten u.a.
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